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INTRODUCTION STL Tonality - Josh Middleton Plugin

STL Tones is proud to present Tonality: Josh Middleton.

The exclusive guitar plug-in suite was developed using Josh Middleton's personal equipment; everything from his
go-to pedals, amplifiers, and cabinet setups has been modeled for his Tonality plug-in, capturing the sonic complexity
of what make’s his guitar tones so distinctive.

Using the most advanced modeling algorithms, our software uses internal circuit simulations from the schematics of
Josh Middleton’s specific amplifiers, including any modifications the amps may have, allowing users to experience
real-time simulations of Josh Middleton’s guitar setup.
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SYSTEM REQUIREMENTS STL Tonality - Josh Middleton Plugin

« Low Latency Audio Interface (ASIO / Core Audio compatible). « High-Z (high impedance) instrument input.
« Digital Audio Workstation (DAW) or a standalone plugin host.

Windows requirements:

- Windows 7 32/64 bit.
- Intel Core 2 Processor Family or better.

Mac requirements: - OS X 10.9.0 +
+ Intel Core 2 Processor Family or better.
We recommend an Intel Core i5 processor or better for the best user experience.

During recording or monitoring, we recommend a buffer size of 128 samples or lower, this is to minimize latency and
improve the play-through experience. This can be set in your audio interface setup utility or in your current DAW
audio settings.
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SUPPORTED HOST SOFTWARE STL Tonality - Josh Middleton Plugin

« To use STL Tones software you need an audio host which can load VST, VST3, Audio Unit (AU), or AAX plug-ins.
 You can also run STL Tones software as a Standalone application.
- This plugin officially supports the following software host:

Pro Tools 12 +: Mac & PC: AAX Native

Logic Pro 9 & 10 (X) 64 bit: Mac: Audio Units

Cubase 9 & 10: Mac & PC: VST/VST3

Ableton Live 9 & 10: Mac: Audio Units/VST/VST3; Windows: VST/VST3

Reaper 5.x: Mac: AU/NVST/VST3; Windows: VST/VSTS.

Note: This plugin comes in 64-bit format for both Mac and Windows, it needs 64-bit hosts to function properly. 32-bit
hosts and operating systems are not supported.
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RECOMMENDATIONS STL Tonality - Josh Middleton Plugin

 Always use the high impedance (Hi-Z) input of your sound card. This will ensure less noise and signal loss. Most
real (pre)amplifiers and stomp boxes have an input impedance of 1MegaOhm, so it would be a good idea to get a
sound card with a TMegaOhm input impedance to use this plugin.

- Always make sure to have the highest input signal before the AD conversion, avoiding clipping.

« Amp sims and stomp box simulators are not noisy, they do not add noise. In fact, they're a lot less noisy than real
hardware. If you have noise issues, check your guitar's electronic circuit, cables, and sound-card settings.

« In almost all cases, amp sims and stomp box simulators don't introduce noticeable latency. STL Tonality doesn't
introduce any noticeable latency. If you're experiencing latency issues, check your sound-card settings (specifically
reduce the “Input Buffer Size to 128 samples”).
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Installation and License Activation STL Tonality - Josh Middleton Plugin

STL Download Center

Please visit https://www.stltones.com/pages/file-downloads where you will find the latest installers for your product.

STL License System

License Information
 Your Activation License code will be in the confirmation email you received after your purchase.

« To login into your user account, go to www.stltones.com and click on the “Login” icon in the upper right-hand corner.
If you don’t have a user account, create one by clicking “Create Account” inside the same login window.

« Multiple Machines: Each activation code can be used on up to 3 different machines, however, the associated email
will always be the email entered during your first activation. If you try to activate the same code on a 2nd machine
with a separate email, the activation will fail.

« Trial Limitations: Only one trial can be requested per account or machine.

« The activation process is similar for trials and full licenses and is laid out below.

8 of 35


https://www.stltones.com/pages/file-downloads
http://www.stltones.com

Full License (Online Activation)

Product Activation - When you first open the plugin, you will be prompted to activate a license. Select
Activate your product “Activate Product’.

A valid license for this product could not be found on this
computer.

If you have purchased a license, you can activate it by clicking on
"Activate Product" and following the instructions.

If you don't have a license and want to evaluate the software, you
can click on "Activate Trial" to start your evaluation period.

Activate Product ‘ ‘ Activate Trial

X Product Activation

a Activate your product - This will take you to the activation screen. Enter your activation code and email
Flokde then Gl o the Serfy: bution o start the scavation address and click “Verify”.

process.

Insert the Verification Code we'll send to your specified E-Mail
address, then click on the "Activate" button to unlock your product.

If you don't receive a Verification Code within 2 minutes, check
your spam folder.

Make sure your computer has an active internet connection.

Activation Code
Tt W 4T W T U el SEI

Format: 3000¢-X000¢-X000¢- XXX XXX -XKXXHXX XXX =X =X -XHK-XHXX

E-mail Address

cation Code
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x Product Activation - You will receive an email to the address you provided from

(<] Activate your product

IR o.Clivations @stltones.com This email contains your 6-digit verification code. Note:
fields then click on the "Verify" button to start the activation

process Check your spam folder if you didn’t receive a verification code.

Insert the Verification Code we'll send to your specified E-Mail
address, then click on the "Activate" button to unlock your product.

If you don't receive a Verification Code within 2 minutes, check

b e - Copy this code from your email and paste it into its field in the Activation menu,
Make sure your computer has an active internet connection. then CIICk “Activate”

Activate O ‘

Activated

Your product is now activated on this computer. * You have nOW u n IOCked you r fu II Iicense !

You can activate this product on 2 additional machines.

‘ Done

10 of 35


mailto:activations@stltones.com

Trail License (Online Activation)

Product Activation - When you open the plugin, you will be prompted to activate a license. Select
Activate your product “Activate Trial,,

A valid license for this product could not be found on this
computer.

If you have purchased a license, you can activate it by clicking on
"Activate Product" and following the instructions.

If you don't have a license and want to evaluate the software, you
can click on "Activate Trial" to start your evaluation period.

Activate Product ‘ ‘ Activate Trial

X Product Activation

B Activate your trial period - This will take you to the trial activation screen. Enter your email address and

Please enter your E-Mail address in the related field then click on Cl iCk 1 ‘Verif bR
the "Verify" button to start the Trial activation process. y .
Insert the Verification Code we'll send to your specified E-Mail

address, then click on the "Activate" button to unlock your trial

period.

If you don't receive a Verification Code within 2 minutes, check
your spam folder.

Make sure your computer has an active internet connection.

E-mail Address

- Verify (3 ‘

Verification Code
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X Product Activation

\Z\ Activate your trial period

« You will receive an email to the address you provided from
rease enter your £l adchess i thereated fied hen lickon activations @stltones.com This email contains your 6-digit verification trial code.
Insert the verification Code well send t6 your speaified E-Mail Note: Check your spam folder if you didn’t receive a verification code.

address, then click on the "Activate" button to unlock your trial
period.

Ifyou dorit receive a Verifcation Code within 2 minutes, check « Copy this code from your email and paste it into its field in the Activation menu,

your spam folder.

1 13 H 7
Make sure your computer has an active internet connection. th e n CI ICk Actlvate .
E-mail Address
Verification Code

Activate ﬂ ‘

« You now have a 10-day trial license!

Activated

Your trial is now activated on this computer.

‘ Done
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MAIN INTERFACE STL Tonality - Josh Middleton Plugin

Footer Controls

@ 9 @

INPUT GATE TUNER STOMP BOXES AMPLIFIER CABINET EFFECTS MIDI OUTPUT

Input and Output Controls & Input Level Listener:

Input will affect how much signal the plugin will receive. This will affect the amount of distortion range of the Gain pots
in the Amplifier and Stomp Sections. Adjust according to your purposes and input signal levels. Output will affect how
much signal the plugin will feed out to your DAW channel. Meters will show if input or output signals are clipping by
appearing red.

Next to the Input control, you will see a ‘bulb’ button. Click on this button to open the Input Level Listener.

Input Level Listener Input Level Listener:
When you are not sure how to set the plug-
1. Select your pickup type in input level correctly, the Input Level
2. Set your guitar volume potentiometer to max Listener will ease the process for you.

Once you open the panel, the plug-in will
listen to your input signal and adjust the

4. Play a few chords (5-10 seconds), the software will .

automatically adjust the Input Level for best performances Input Level accordingly.

The first thing you need to do is make sure

the preamp level on your sound card is set

correctly.

3. Adjust your soundcard input level to peak around -6dB

PICKUP TYPE

Medium Output v




For the Input Level Listener to work properly, it is advised to leave around 6dB of headroom on the A/D converter,
which usually means having the sound-card input meter peaking below the "yellow" zone while playing normally. If the
meter LEDs are yellow or red, turn the preamp level down until you're in the "green" zone.

Once your input signal is set correctly, select the Pickup Type from the menu:
- Low Output is for single coil or vintage pickups with low sensitivity
- Medium Output is for passive humbuckers with balanced output

- High Output is for active or hot passive humbuckers

Now start playing some riffs and the software will adjust the input level according to your guitar signal and the
selected Pickup Category.

Here are some reference values you should see in the Input Level Listener if you've set everything correctly:
- Low Output pickup: Input Level in the -6dB to -3dB range

- Medium Output pickup: Input Level in the 0dB to +3dB range

- High Output pickup: Input Level in the +6dB to +9dB range

If you're seeing values that are clearly different from the reference level, adjust the sound card preamp and repeat the
process.
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Gate: Cuts unwanted noise spill, hiss, or hum by setting a threshold at which the input signal needs to be above for
processing.

Tuner: Click to open the Tuner. The tuning indicator light will span from left to right and turn green when the note is in
tune (middle position). When using the Tuner, you can switch off the output sound of the plug-in for convenience by
clicking the speaker icon button on the bottom left side of the window. If you’re wanting to change the master tuning
frequency to something other than 440Hz, you can do so by clicking on the reference text box on the bottom right
side of the window. Keep in mind that the Tuner runs in a modal window, so all the other controls in Tonality are
disabled until you close the Tuner window.

440

SENSITIVITY REFERENCE
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Stomp Boxes

1.

Compressor: A versatile compressor for dynamic control. Ratio 1:1 to 4:1. Attack: 1ms to 20ms. Release: 50ms
to 500ms. Level: 18dB +/- of make-up gain.

Pitch: Classic +1 and -1 voiced octave-style stomp box for real-time pitched effects. Both Octave -/+ controls are
processed in parallel, from 0-100% wet allowing for creative blends of both up/down pitch effects and the original
dry signal. Dry: controls the amount of original signal being blended into processed pitch effect from 0-100%.

Overdrive 1: This is based on the Fortin© TEMPEST™ Architects Signature Overdrive Pedal.

Overdrive 2: This is based on the Maxon© OD808 pedal.

PRESETS ROUTING

AR oee VD) STLIONALLTY  ww V@)
- JOSH MIDDLETON E—

octave - octave + balance

attack release hipass lopass tone

compressor overdrive 1 overdrive 2

Designed by STL Tone: Designed by STL Tones
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Amp Select: Select which of the 3 amp models you wish to use.

PRESETS

B S £ STLTONALITY — s @ [

JOSH MIDDLETON

Amp 1

This model is based on a Peavey© 5150™ Block Letter amplifier.

Amp 2

This model is based on a Peavey®© Triple XXX™ amplifier.

Amp 3

This model is based on a Mesa Boogie© Dual Rectifier© Multi-Watt™ ampilifier.

Disclaimer:

All names of amps, pedals, cabinets, microphones, and other gear and/or accessory brands are trademarks owned by their respective manufacturers and are in no way affiliated with
STL Tones.

Product names are simply used for the purpose of identifying the hardware that was used as reference when creating the digital models.

B M © @

STOMP BOXES AMPLIFIER CABINET EFFECTS

OUTPUT
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Cabinet Section: Click to open the Cabinet view. Here you can change cabinet, speaker, and microphone models.

PRESETS

AN - S 1 STLTONALLTY — s & [

JOSH MIDDLETON
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o= , - @
LPF 7 / 7 LPF

RESONANCE RESONANCE

@ 9 vV [ = B H © @

INPUT GATE TUNER STOMP BOXES AMPLIFIER CABINET EFFECTS MIDI

OUTPUT

Y

You are able to move the microphone around the speaker with 4 degrees of freedom: X (horizontal axis), Y (vertical
axis), Z (distance), and W (angle). Each of Josh Middleton’s six go-to speakers has been measured with four different
microphones in more than 156 positions, totaling 3744 IRs captured to achieve the ultimate realism and accuracy.
You can further tweak your tone by using the featured Hi/Lo pass filters, Resonance control, change the volume of
each microphone by using the related volume slider, flip the phase with the related button, link options for Distance,
HPF, LPF controls and set the mix of the 2 mics to find the perfect balance.
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It is also worth noting that changing the microphone distance introduces a slight delay in the output signal, resulting in
phase cancellation that may help remove unwanted frequencies, so feel free to experiment.

You can even switch off the cabinet by setting it to “Disconnected”. By doing so, the amplifier sound will pass through
the cabinet section unprocessed. Clicking on the Cabinet button while the Cabinet view is open will bypass the
cabinet section.

Tip 1: Even if you can change the microphone distance and angle using the related knobs, all 4 degrees of freedom
are conveniently accessible directly via the crosshair by using key modifiers: left-clicking your mouse and dragging
will move the microphone in the X/Y axis, left-clicking+ctrl and dragging will move the microphone on the Z axis, right-
clicking and dragging will angle the microphone.

Tip 2: As pointed out in the Amplifier section, each cabinet has its own impedance curve which is connected to the
amplifier power section, but in Tonality, you’re free to use 2 different cabinets at the same time. In such a case, the
impedance seen by the power amp will be the combination of the 2 impedances, so using the mix slider can help you
achieve some very unique tones.

Tip 3: In the cabinet menu you can also find a “Disconnected” option, what does it mean in terms of the impedance
seen by the power amplifier? Setting the cabinet to “Disconnected” will achieve the same result as connecting the
amplifier to a purely resistive load, with the result of flattening the poweramp in terms of frequency response and
reducing the power amp controls (ex. Presence) excursion.

Tip 4: Setting the cabinet as “Disconnected” is not the same as bypassing the cabinet section entirely! This is
extremely important to know when using Tonality with external IRs! If you bypass the cabinet section, the amplifier will
keep seeing the load related to the selected cabinet(s) even if the cabinet and microphone are not processing the
signal. If you change the cabinet when the cabinet section is bypassed you’ll still notice some differences in how the
amp sounds and reacts, because you’re still changing the load connected to its poweramp. For the most transparent
poweramp sound when using external IRs, you should set the cabinet as “Disconnected” and switch off the cabinet
section. Feel free to experiment with various combinations to find some secret tones!
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EFFECTS SECTION

STL Tonality - Josh Middleton Plugin

PRESETS

STLIONALLTY

JOSH MIDDLETON

@@@@

delay

ALK

BPM
PONG on/ off SYNC

Designed by STL Ton

STOMP BOXES AMPLIFIER CABINET

20 of 35

ROUTING v0.5.0 x86_64

Moo v (2]

OO
OOO0)

reverb

Designed by STL Tones

N © @

EFFECTS MIDI OUTPUT



Equalizer: Features three bands of parametric EQ controls with adjustable gain (P Gain) and bandwidth (Q), as well
as classic HP/LP filters making it an indispensable tool for shaping your tone. Also included are Low and High
shelving filters (LS/HS) with a +/- of 18dB allowing for further control of your guitar tones’ low-end response whilst
letting you add air and sheen, making it perfectly fit into your mix with ease.

Delay: There are 12 controls for the Delay Pedal.

Wet/Dry controls the balance of the dry and wet signal. F.back controls the feedback and repeats of the Delay. Time
sets the delay time note. This value can be synced to the DAW by clicking the BPM Sync switch. You can also use
the *Tap’ button to Tap a specific delay time of your choice. LoPass controls the eq of the delay repeats from 1000Hz
to 22050Hz. HiPass controls the eq of the delay repeats from 20Hz to 1000Hz. Depth controls the modulation depth
of the delay repeats from 0-100%. Rate controls the modulation rate of the delay repeats from OHz to 10Hz. Ping
Pong Switch turns the “ping pong” delay effect On/Off. On/Off button engages or bypasses the effect.

Reverb: There are 8 controls for the Reverb Pedal. Wet/Dry controls the balance of the dry and wet signal. Delay
controls the delay time before the reverberated signal appears. Length which sets the time of the Reverb, from
0-10seconds without temporal reference. LoPass controls the eq of the delay repeats from 1000Hz to 22050Hz.
HiPass controls the eq of the delay repeats from 20Hz to 1000Hz. Depth controls the modulation depth of the delay
repeats from 0-100%. Rate controls the modulation rate of the delay repeats from OHz to 10Hz.
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MIDI

STL Tonality - Josh Middleton Plugin

MIDI Setup

Standalone application

[ Audiol/o |

PRESETS

‘ r, ‘ < H Default

Audio/MIDI Settings

Feedback Loop: | | Mute audio input

Output: ‘ Orion 32
Input: ‘ Orion 32

(v) output1

. () output 2
Active output channels: | —
( ] Output 3

() output 4

Active input channels: | -

Sample rate: ‘ 48000 Hz

Audio buffer size: ‘ 512 samples (10.7 ms)

e |:|

\ Bluetooth MIDI

* Open the standalone version and click on the Audio I/0 button.

« Select the MIDI inputs (device) connected to the computer you want to
use.

- Enable the MIDI Learn functionality by right-clicking on one of the
Tonality plugin model's learnable controls, a popup menu will appear
with two MIDI binding options:

1. MIDI Learn - Preset:

this will store the MIDI <] Default | | ——
bindings at the Preset MIDI Learn - Global
level. Preset-level
bindings have priority over
Global Bindings, meaning that assigning a MIDI PC or CC message at
the preset level will override existing bindings of the same messages at
the Global level if any. Preset-level bindings are saved within the active
preset and recalled when the preset becomes active. Remember to
save the preset using the Preset Manager (check the Header Controls
section) if you want to persist the MIDI bindings.
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2. MIDI Learn - Global: this feature will store the MIDI bindings globally for the application/plug-in. Global bindings
are shared among presets, meaning the registered MIDI assignments will remain active even when changing presets
(unless overridden by a Preset level assignment as described above).

« Once you select the binding type, the application will notify you that it's ready to perform the assignment: simply
press the MIDI control you want to assign to the selected parameter/functionality on the MIDI controller and the
binding will be stored, making the MIDI Learn popup menu disappear. You can now adjust that plug-in parameter
value using the connected MIDI controller.

X MIDI Settings Using a MIDI message to change a preset

| Global Bindings | Preset Bindings - If you want to recall a specific preset using your MIDI

controller, all you need to do is load the preset you want to
Feature Message Content Action assign the MIDI message to, right-click on the preset menu
e eioue e located in the left section of the header and select MIDI Learn
- Global. This will trigger the previously described MIDI Learn
functionality and the provided MIDI message will be bound to

recall that preset. This is very useful in a live-playing situation.

- The same can be done with the Previous/Next Preset
buttons placed on the sides of the preset menu if you want to
use your MIDI controller to switch from a preset to the next or
previous one without the need to reach your computer. These
types of bindings can only be stored at the Learn Global
level.

Parameter Message i Action

o] (5o ] I All stored MIDI assignments can be reviewed and modified
e  in the MIDI settings panel, accessed by clicking on the MIDI
icon in the GUI's footer section.
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AMP MODULES STL Tonality - Josh Middleton Plugin
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AMP 1: Based on a Peavey© 5150™ Block Letter, this two-channel, 120W all-tube amplifier is well known for its high-
gain overdrive channel and has been the undisputed go-to guitar amp for heavy rock and metal guitarists since its
release in 1992.
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AMP 2: Based on a Peavey© XXX™ amplifier, this three-channel 120W high-gain amp specializes in its versatility.
Including independent volume controls on each of the three channels (Ultra, Crunch, and Clean), this amp also
features the three-position “Damping” switch that allows adjustment of the amp’s ability to control the speaker cone
motion after a signal disappears. A high damping factor (TIGHT) reduces cone vibration quicker than a low (LOOSE)
damping factor. This model also includes the mod where the noise gate has been shorted (bypassed) in Josh’s
XXX™,
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AMP 3: Based on a Mesa Boogie© Dual Rectifier© Multi-Watt™ this three-channel 100W amp is capable of
achieving any tone and music style with its unique CLEAN and PUSHED modes in Channel One, RAW, VINTAGE,
and MODERN voicing styles for Channel’s Two and Three. Touted as the best Dual Rectifier© this amplifier is a
heavy music icon.
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HEADER CONTROLS STL Tonality - Josh Middleton Plugin

PRESETS TEMPO (BPM) ROUTING v0.5.0 ARM64
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JOSH MIDDLETON

S PRESETS . Resize: Click to resize the plug-in interface. 3 possible values

) 1« Seladl 2l are available: 50%, 75%, and 100%. In addition to these 3
Load modes, you can fine-tune the size using the resize function in
v Default the bottom right corner.

= Presets: Click to manage the Tonality default and user settings.

The Preset manager is divided into 3 sections: Load, Edit, and
Create. Under the Load section you'’ll find all the available
RSN Danks where each bank entry has a submenu featuring all the
Delete presets it contains. Under the Create section, you can either
Gy add a Preset to the current Bank or create a new Bank entirely.
Paste When creating a new Bank, the currently loaded Preset will be

copied into it, you can tweak it later using the Edit options. Tip:
if you want to rapidly copy settings from one instance to another track in a DAW project, you can use the Edit >
Current Preset > Copy function. This will store the settings in the clipboard, so you can move into your second
instance and select Edit > Current Preset > Paste to paste the stored settings.

Current preset Rename

Current bank Revert

Vi
Create Save

New Preset

New Bank

Keep in mind that settings in the clipboard are preserved until there is at least 1 instance of Tonality available. If you
close all the instances and open a new one later, the clipboard will be cleared out and you won’t be able to paste.
Copy/Paste only works between plug-ins of the same format: you can Copy/Paste from a VST3 to another VST3 or
from an AU to another AU, but you can’t from a VST3 to AU, etc.
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Tempo (BPM): Tempo change feature in standalone mode only. Note: Tempo is saved at the preset level.

Routing: Click to change the routing of your virtual rig. Tonality supports 3 different routing modes: Mono, Mono/
Stereo, and Stereo. Mono: all the rig sections will process the signal in Mono mode (this is the most CPU-efficient
routing) Mono/Stereo: all the rig sections will process the signal in Mono mode until an element supporting the “Mono-
To-Stereo-Split” is encountered. When this happens, the signal is split and the remaining elements in the chain will
automatically switch to Stereo processing. Delay and Reverb are typical models supporting the “Mono-To-Stereo-
Split”, so when using those pedals in Mono/Stereo routing mode, the signal will be split and the subsequent effects
will work in Stereo mode until the signal reaches the output. Stereo: all the rig sections are internally doubled and will
process the signal in Stereo mode (this is the most CPU-intensive routing)

Tip 1: In the plug-in versions of Tonality, if the Routing menu only features the “Mono” option you’ve probably loaded
it into a Mono track. Use a Stereo track if you want to unlock the other modes.

Tip 2: In the standalone versions of Tonality, if the Routing menu only features the “Mono” option you’ve probably only
set a single output in the Audio /O settings. Enable at least 2 outputs from the Audio 1/0O menu, close the application,
and re-open it: you should now see all the Routing options available. 21 of 31 Routing Lock: click to lock the current
Routing Mode. This control is useful when you want to audition different presets maintaining the routing untouched.
Since the Routing Mode is saved in the Preset itself, loading a Preset may change it. If you want to avoid it, just
activate the lock and it will be kept fixed until you unlock it, avoiding overrides.
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SUPPORT STL Tonality - Josh Middleton Plugin

For technical issues or any problems experienced with our software contact us via the contact page at
www.stltones.com. Before doing so, follow our Troubleshooting questions below to see if these fix your issue.

Support Information to be provided

- To help us assist you the best way possible, please attach the following information to our support team:
Product Version Number (e.g STL Tonality - Josh Middleton V1.0.0.)

- Version number of your audio system (e.g ProTools 11.2.2, Logic 10.2.4)
- Interface/hardware (e.g. Focusrite Scarlett 2i2, Universal Audio Apollo Twin, etc.)
- Computer and operating system info (e.g MacBook Pro OS X 10.9.6, Windows 10 ver 1709, etc.)

- Please include a detailed description of your problem.
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TROUBLESHOOTING STL Tonality - Josh Middleton Plugin

Troubleshooting

Having issues with our software?
Uninstall / Reinstall

This will repair possible broken permissions, fix corrupted files, and remove old versions of our software

Steps:

1. Close out of all host software (Pro Tools, Logic, Cubase, etc.)

2. Uninstall your plug-in.

3. Open your host software and ensure that the plug-ins no longer showing up in the inserts list. If the plug-ins are still
present, locate the files on your computer and remove them manually. Once they no longer show up in your DAW
(after restarting it), move on to step 4.

4. Close out of all host software.

5. Follow the installation and licensing procedure outlined in the “Installation & License Activation” section of this
manual making sure you have the latest installers for the plug-in.

6. Run the latest installers and start your host program.

7. Follow the STL licensing prompts, ensuring that your host program is reading the latest version of our software.
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Repair your computer’s hard drive:
Repair permissions on your computer.

Instructions: Mac & Windows

Run your host software as an administrator (Windows-only) :

This can fix a variety of issues that result in crashing or error messages on Windows DAWSs that are loading our plug-
ins for the first time.

Steps:
1. Exit your host program (Pro Tools, Cubase, etc.)

2. Right-click on the icon for that host program and select “Run as an Administrator.” You will only have to do this
once, meaning you can open up the host program normally the next time.

31 of 35



TROUBLESHOOTING STL Tonality - Josh Middleton Plugin

How do | find my plugin in Reaper?
If you cannot find your STL Tonality plugin in Reaper, follow these steps to make the plugin available.

Step 1: Follow the installation and licensing procedure outlined in the “Installation & License Activation” section of this
manual making sure you have the latest installers for the plug-in.
Step 2: Now check if the plugin is installed on your computer in the default folder.

File Locations: MAC

VST: Macintosh HD/Library/Audio/Plug-ins/VST/STL Tonality Josh Middleton
File Locations: Windows

64-bit VST: C:\Program Files\VSTPIugins\STL Tonality Josh Middleton

If you don’t find the respective files please reinstall your STL Tonality Product. If the relevant plugin files are in the
above folder, perform a rescan:

In Reaper, press [Ctrl] + P (Windows) / [Cmd] + [,] (Mac) to access Preferences.

Go to Plug-ins > VST.

Under “VST Plugin Path,” make sure that the following path is listed (if not, add it):
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Windows:

64-bit VST: C:\ Program Files \ VSTPIlugins \ STL Tonality Josh Middleton

Mac:

System HD > Library > Audio > Plugins > VST

Click on Clear Cache/Re-Scan. Create a new session with a supported sample rate, add a track and load your STL
Tonality plugin. If the pop-up window tells you to activate please press follow the installation and licensing procedure
outlined in the “Installation & License Activation” section of this manual.

How do | find my plugin in Pro Tools?

If you cannot find your STL Tonality plugin in Pro Tools, follow these steps to make the plugin available.

Step 1: Follow the installation and licensing procedure outlined in the “Installation & License Activation” section of this
manual making sure you have the latest installers for the plug-in.

Step 2: Check if the plugin is installed on your computer in the default folder.

VST: Macintosh HD / Library / Audio / Plug-ins / VST / STL Tonality Josh Middleton
AAX: Macintosh HD / Library / Application Support / Avid / Audio / Plug-ins /STL Tonality Josh Middleton

File Locations: Windows

64-bit VST: C:\Program Files\VSTPIugins\STL Tonality

64-bit AAX: C:\Program Files\Common Files\Avid\Audio\Plug-Ins\STL Tonality

If you don’t find the respective files please reinstall your STL Tonality Product. If the relevant plugin files are in the
above folder, perform a rescan:

To do a Rescan you need to delete certain files on your computer depending on your Pro Tools version. Please follow
the official Avid website to do this.
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The plugin makes no sound at all, why is this happening?

You have most likely not activated the software yet, or the license file has moved to a different location and the
software can’t find it anymore. Follow the installation and licensing procedure outlined in the “Installation & License
Activation” section of this manual, making sure you have the latest installers for the plug-in.

Where do | find the installers?

Visit https://www.stltones.com/pages/file-downloads where you will find the latest installers for your product.

Where is the STL Tonality Plugin located on my computer?

Mac:

AudioUnits: Macintosh HD / Library / Audio / Plug-ins / Components / STL Tonality - Josh Middleton

VST: Macintosh HD / Library / Audio / Plug-ins / VST / STL Tonality - Josh Middleton

AAX: Macintosh HD / Library / Application Support / Avid / Audio / Plug-ins / STL Tonality - Josh Middleton
Windows:

64-bit VST: C:\ Program Files \ VSTPIlugins \ STL Tonality - Josh Middleton

64-bit AAX: C:\ Program Files \ Common Files \ Avid \ Audio \ Plug-Ins \ STL Tonality - Josh Middleton
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